Using EndNote Online
Class Outline

1 Overview
1.1 Functions of EndNote online

1.1.1 Bibliography Creation
EndNote online works with your word processor to create formatted bibliographies according to thousands of styles.

1.1.2 Reference Organization & Sharing
EndNote tracks your references online in your personal, password-protected library. You can access your library anywhere there is Internet access and share references with other EndNote users.

1.1.3 Connectivity
EndNote online includes three different ways to import references from online databases—
- Online Search allows you to search online databases from within EndNote.
- Direct Export downloads references directly from online databases into EndNote.
- Importing Text Files allows importing of text files saved from online database searches.
You can also do seamless transfers between your EndNote desktop and online libraries.

1.2 EndNote online System Requirements

1.2.1 Web Browser
- Microsoft Internet Explorer 7.x or later
- Firefox
- Safari 4.x or later

1.2.2 Windows Plug-in Requirements
- Microsoft Windows XP SP3 or later, Windows Vista, Windows 7, or Windows 8
- Microsoft Internet Explorer 7.x–9.x with the latest service pack set as the default Web browser
- Firefox for Windows set as the default Web browser

1.2.3 Macintosh Plug-in Requirements
- Macintosh OS X 10.6 or later
- Microsoft Word 2008/2011
- Firefox for Macintosh set as the default browser

1.3 Word Processor Compatibility

1.3.1 Windows
• The Format Paper feature works with any word processor capable of producing rich text format (RTF) documents.

1.3.2 Macintosh
• Cite While You Write — Microsoft Word 2008/2011
• The Format Paper feature works with any word processor capable of producing rich text format (RTF) documents.

1.4 General Statistics
• Store up to 50,000 references if you do not have EndNote X6 or later, or an unlimited number of references with EndNote X6 or later
• Create and share up to 5,000 personal groups
• 3 ResearcherID groups (if you also have a ResearcherID account)
  References in your ResearcherID groups count towards the total per library reference limits
• 50 predefined reference types

2 Register for an EndNote Account
To use EndNote online you need to register for an account. Your account name will be your e-mail address. Please use a permanent address. This address will be used to send you important information about your account. You will also need to create a strong password including at least one number and one symbol, and it must be at least 8 characters long.

2.1 Institutional Access to EndNote online and Roaming
If you have already created a personalized Web of Knowledge profile or ResearcherID account, use the logon for that; you do not need to create a new account.

2.2 EndNote Online from an EndNote Purchase
If you are using EndNote, you can also register through the Sync section of your EndNote preferences, or during your first synchronization in EndNote X7.

3 The My References Tab—Your “Home Base” for Working in EndNote online
The My References tab displays the contents of your EndNote online library. From here you can view the complete list of references, or only the references in a single group. If other EndNote users have shared groups with you, these can also be displayed on the My References tab.

The Quick Search feature is also accessed on this tab, allowing you to search your entire EndNote online library, or just a single group.
As you add references to your library and organize them into groups, you will see the results shown here, on the My References tab.

---

4 Collecting References—The Collect Tab

References can be entered in your EndNote online library in several ways.

1. References can be transferred from an EndNote library (EndNote X.0.2-X5) or synchronized with an EndNote Library (EndNote X6 or later)
2. References can be exported from the traveling library contained in Word documents
3. References can be exported directly from some online databases, such as the Web of Science, using Direct Export
4. Some online databases can be searched from within EndNote online and the search results transferred to the EndNote online library
5. References can be saved as text files and then imported into EndNote online
6. References can be manually typed into EndNote online records

Numbers 1–3 will be dealt with below. Numbers 4–6 can be accessed through the Collect tab.

---

4.1 EndNote Sync

EndNote X7 or later can synchronize an unlimited number of references and 5,000 groups between an EndNote online and desktop library, including up to 5 gigabytes of attachments. References can also be synchronized to a second desktop computer and/or an EndNote iPad library (EndNote for the iPad is available in the iTunes store, with a price of $.99 until July 31, 2013). For the first synchronization on any device, there are several important considerations.

1. For the first synchronization on any device, ALL references and custom groups will be copied in both directions. This will result in duplicates if the same references reside on the device and EndNote online.
2. References and custom groups will be synchronized, but group sets, smart groups, and combined groups (groups from groups) will not be synchronized between your EndNote desktop and online library. Therefore, if two groups in an EndNote desktop library have the same name, but are under different group sets, they will have the same name in EndNote online, but will have no group set to distinguish them. Consider renaming groups of the same name to more easily tell them apart in EndNote online before your first synchronization.
3. If you synchronize to a second or third computer using EndNote X7, group sets will also be synchronized, but only on the desktop (in X6, all groups will appear under an Unfiled Groups group set and you will have to recreate your group sets).
4. Only one EndNote library on a device and one EndNote online account can be synchronized, so it is best to keep all your references in one library and use groups to categorize them.
5. **Make a backup copy of your EndNote desktop library before your first synchronization by selecting Compressed Library from the File menu.** This provides a backup in case you have problems. EndNote will prompt you to do this, but this command can be used to create a backup of your library at any time. This backup will have a .enlx extension. Any compressed library created after your first synchronization will contain synchronization information, so you want to make a backup before your first sync.

6. If you delete references or attachments from one library, they will be deleted from the other synchronized libraries with the next synchronization.

7. Synchronization will always be of the complete library. There is no selective synchronization.

---

**4.2 Transfer from EndNote (EndNote X5)**

You will be presented with a window where you can select which direction you wish to transfer your references, either from EndNote desktop to EndNote online, or EndNote online to EndNote desktop. You can also select specific groups for transfer. The Transfer feature is not available in EndNote X6 or later.

The transfer feature copies references, it does not synchronize references.

---

**4.2.1 Transferring File Attachments with EndNote X5**

By default EndNote X5 will also transfer files and figures attached to records. This option can be deselected. When transferring references with attachments, all new attachments are transferred in both directions regardless of the selected transfer direction. That is, attachments are added to both sides during a transfer even though the transfer occurs in one direction.

Points to consider:

- If you delete an attachment from a reference in EndNote desktop, then you must manually delete that attachment from the reference in EndNote online and vice-versa if you wish to keep the two references in sync.
- EndNote online has no limit on the number of file attachments per reference. When transferring references with attachments from EndNote online to EndNote desktop, *all attachments* are transferred to the desktop, even if this number exceeds the 45 file attachment limit in EndNote.

---

**4.3 Exporting References from the Traveling Library**

Please see the section 8.7 on exporting references from the traveling library later in this outline.
4.4 Direct Export

Direct Export provides a quick and easy way to transfer data from online databases that support it. Direct Export requires the EndNote online plug-in for Internet Explorer or Firefox for all databases except those from Thomson Reuters Web of Knowledge or EBSCOhost.

4.4.1 Thomson Reuters Web of Knowledge (with and without the Plug-in)

- After obtaining your results in the Web of Knowledge, select the references you want to export to EndNote online, then select the "EndNote Web" button (if you do not have the plug-in installed) or the "EndNote" button to save your references. (Note that “EndNote Web” was the previous name for EndNote online.)
- The references you selected will be imported into the Unfiled folder in your EndNote online library.

If you are simultaneously logged on to both the Web of Knowledge and EndNote online, references that were imported from the Web of Knowledge will show links between the two.

4.4.2 Other Databases—Using Internet Explorer Plug-in

Direct Export with the Internet Explorer plug-in for Windows will give you an option of importing references from many online databases into either your EndNote or EndNote online library during the import process.

4.4.3 Other Databases—Using Firefox Plug-in

Direct Export with the Firefox plug-in works on both Windows and Macintosh computers and allows you to import references from many online databases into EndNote online. Note that this option does not give you a choice between downloading to EndNote or EndNote online during each import as the plug-in for Internet Explorer does. However, you can set in your Firefox options whether you wish to import to EndNote online or into EndNote. Importing into an EndNote library requires separate setup.

4.5 Online Search

The default option when you click on the Collect tab is Online Search. This option allows you to search online databases from within EndNote online. With the exception of the PubMed and Web of Knowledge databases, this feature is limited to searching databases using the z39.50 Internet protocol. This is a special protocol designed for the search and retrieval of bibliographic data. Because of this special protocol, there are limitations in how this feature works with firewalls and proxy servers. In general you will be able to search public access databases such as university book catalogs, large public library catalogs, and national catalogs such as the Library of Congress without problems. However, subscription catalogs that require IP authentication will not work because this protocol does not work as your browser does and
will not be able to send an authentication through a proxy server. You will still be able to access these databases and import the references into EndNote online using one of the other methods of importing.

- To begin an Online Search, select the drop-down menu above the Connect button. You will see a list of available online catalogs. Please note that EndNote online administrators for your site can control which online catalogs are displayed on this list, so the list may vary in length. If you see more options that you want to work with, you can customize this list by selecting the Select Favorites link. After you select favorites, only your favorites will be available in the drop-down list.
  - Select the catalog you wish and click on the Connect button.
  - You will be presented with a search window where you can enter your search criteria, then click on the Search button to perform the search.
  - EndNote online will report how many references were found. Click on the Retrieve button to retrieve the references.
  - The references will appear in the Online Search Results list.
  - Mark the references to copy to your personal EndNote online library, then select the group they will be added to from the drop-down list. The marked references will be added to that group and can then be viewed on the My References tab.

### 4.6 Import References

#### 4.6.1 Saving Data from Online Databases

All importing uses a pattern matching process where the pattern of the tags in the data is matched against the pattern of the tags in the import filter. It is very important that data be saved in the tagged format that matches the filter that will be used to import it. Below is an example of tagged text. The tags are on the left and the data follows them.

```
TI - The Scale and the Feather: A Suggested Evolution
AU - Rex, Tiberius
```

Instructions on how to save the data will vary depending on the database provider. You can find instructions for many different database providers in the EndNote online Help files.

- Select the Help link in the upper right corner of the EndNote online screen.
- Click on the Import Formats link under the Collect Heading. This will display a table with instructions for saving the data from different providers so that it will match the EndNote online filters.
- Locate the database provider for your data on this list. You can usually find the database provider’s name on the web page you are searching, often in a page header.
- Save (download) the data according to the instructions in the table. It is best to save the data somewhere you will easily remember, like your desktop.
- Return to your EndNote online library to import the data.
4.6.2 Importing the Saved Data

- On the EndNote online Collect tab, select the Import References option.
- Click on the Browse button to select the data file you saved (downloaded).
- Locate the file you saved. EndNote online may not always display the download location, but will display a standard dialog window where you can locate it.
- Select the matching filter from the Import Option drop-down list of available filters. If you do not want to see the complete list, you can customize this list just as you did the list in Online Search.
- Select the group you want to import into from the To drop-down list.
- Click on the Import button. Your saved references will be imported into the group you chose, and you can view them using the My References tab.

4.7 The Capture Button and Bookmarklet

The Capture button on the Internet Explorer or Firefox toolbars for EndNote online can be used to import data from the Web that is not within bibliographic databases, such as book information from Amazon.com or video information from YouTube videos. Please note that it will generally not import all the information, so you will need to add the rest manually.

The Internet Explorer plug-in may require administrator access to install on your computer. If you are unable to install it, you can still use the Capture button by installing the Capture bookmarklet. You can find the Capture bookmarklet in the Download Installers section on the Options tab.

Some databases will allow you to capture multiple records while others may only allow you to capture one record at a time.

4.8 New Reference

Unfortunately, not all references can be imported from online databases, so you may occasionally need to enter a reference manually. You can do this by selecting the New Reference option on the Collect tab.

The reference type you select will determine which fields are available in the data entry screen. Some fields have special properties and must have information entered in special ways.

- Personal author and editor names should be entered in the format Last Name, First Name and each name should be entered on a new line. So John Smith and Peter Jones would be entered as—

  Smith, John
  Jones, Peter

- For corporate names, put a comma at the end of the entire name. So the University of California would be entered as—

  University of California,

- The Year field should have all four digits of the year.
• Keywords must be entered with each keyword on a separate line, much like authors.
• File Attachments: You can attach up to 5 files at a time, but there is no limit to the total number of file attachments per record. There is no restriction to the size of individual file attachments; however, there is a limit of 5G total attachments for EndNote X6 or X7 users, and 2G attachments for everybody else.
• Figure Attachments: You can attach only one figure per record. There is no restriction to the size of a figure attachment, but figure attachments do count towards the attachments limits for your account.

At the bottom of the data entry screen you can select the groups you wish to add this reference to.
Reference data will be saved automatically as you type.

5 The Organize Tab
This is where you can organize your library into groups, share your groups with other EndNote online users, and configure how groups other users have shared with you will be displayed and used.

5.1 Manage My Groups
The Manage My Groups option will let you create up to 5000 groups within your EndNote online library and share them with others.

• Mark the Share box to share a group with other EndNote online users, then select Manage Sharing for the group. You will need to enter the EndNote online account name (e-mail address) for each user’s account you want to add. File attachments are not shared: only the owner of the group will see file attachments.
• Select Rename to change the name of one of your groups.
• Select Delete to delete a group.

5.2 Others’ Groups
Just as you can share your groups with other EndNote online users, they can share their groups with you. However, you may not wish to see all of their groups or have all of their groups searched when using Cite While You Write (CWYW). Here you can select which groups others have shared will be displayed on the My References tab and if they will be searched with CWYW. You can change these options at any time.

5.3 Find Duplicates
The find duplicates option will search your EndNote online library for duplicates and automatically mark the newer duplicate references. EndNote online will consider a reference a duplicate if the authors, title, year, and reference type are the same.
Duplicates can be added to your Quick List or a group of your choice, or deleted, in this screen.

5.4 Manage Attachments
This option displays a list of all file and figure attachments, as well as information on how much of your allocated attachment space you have used.

6 The Format Tab
Here you can create independent bibliographies, format papers using word processors other than Microsoft Word, download the Microsoft Word plug-ins, and export references so they can be imported into other database or bibliographic software programs.

6.1 Bibliography (Optional)
This option allows you to create independent bibliographies according to the style of your choice.

- Bibliographies can be created from a single group, all the references in your library, the references in your Quick List, or from groups others have shared with you.
- The bibliographic styles list can be customized to include only the styles you work with using the Select favorites option.
- Bibliographies can be saved as text files, rich text files (which can be read in almost all word processors), or HTML files for the Web.

After selecting the references, styles, and output file format, you can Save your bibliography to a file on your computer, E-mail your bibliography, or Preview and Print your bibliography.

6.2 Format Paper (Optional)
EndNote online can be used to format citations and bibliographies in any word processor that can create a rich text format (RTF) file or with Open Office. To prepare a document for formatting—

- For each citation in the paper, insert the author’s last name and the year in a set of curly brackets in this format: {Smith, 1980}.
- For grouped citations, insert the citations in a set of curly brackets with semicolons between them, in this format: {Smith, 1980; Jones, 1990}.
- If there may be more than one citation in the library with the same author and year, add a portion of the title to the citation after a second comma: {Smith, 1980, dinosaurs’ extinction}.
- Add any line spacing to the end of the document and a bibliographic title.
- Save the document as an Open Office (.ODT) document if using Open Office, or as a rich text format (RTF) document if using any other word processor.
- Close the document.
After preparing the document, select the Format Paper option on the Format tab in EndNote online.

- Select the document you prepared and saved using the Browse button.
- Select the bibliographic style from the drop-down list.
- Click on the Format button to format the paper.

EndNote online will create a copy of the document with formatted citations and bibliography. By default, it will assign a name to the new document by combining the old name and the name of the bibliographic style that was selected for the document. This new document can now be worked with as you would any other word-processing document.

6.3 Export References (Optional)

This feature works much like the Bibliography feature. You can export all the references in your library, your Quick List, the references in a specific group, or references in a group someone has shared with you. The main differences between this and Bibliography are that—

- References exported using Export References will always be saved as plain text files because they are meant to be imported into other database or bibliographic software programs.
- The bibliographic styles available here are either delimited or tagged and are designed to be imported into other programs.

6.4 Cite While You Write Plug-In

Selecting the Cite While You Write Plug-In option on the Format tab allows you to download and install the Cite While You Write (CYWY) plug-in for Microsoft Word. You do not need to install the plug-in if you are using EndNote because EndNote includes CWYW plug-ins for both EndNote online and EndNote desktop.

7 Quick Search

The Quick Search feature in EndNote online is very similar to that of many online database search engines. It will search all fields in the library, and you can search the entire library or just one group within the library. There is no way to limit your search to specific fields, as there is in EndNote on the desktop. Search terms can be combined or limited as shown in the examples below.

- dinosaur extinction: Enter multiple words to search for all records containing any of those words. This search would find any record containing either dinosaur OR extinction.
• “dinosaur extinction”: Enter a phrase in double quotation marks to find records containing that phrase. This search would find only records containing the phrase dinosaur extinction.

• dinosaur +extinction: Place a plus sign (+) in front of any word that must be present in the records found. This search would find only records containing dinosaur AND extinction. The words would not need to be in the same field, but both would have to be present in the record.

• dinosaur -extinction: Place a minus sign (-) before any word that must not be present in the records found. This search would find records that contained dinosaur but did not contain extinction. Note that the minus sign can only be used in combination with another search term, so you could not enter –extinction alone, for example.

8 Cite While You Write (CWYW)

The EndNote online Cite While You Write commands will display a menu and toolbar if used in Word 2003, 2008, or 2011, and a tab on the Word ribbon if used with Word 2007, 2010, or 2013. These commands will allow you to search your EndNote online library for references, insert those references into your Word documents, and instantly format the citations and bibliography according to the bibliographic style of your choice.


<table>
<thead>
<tr>
<th>Word 2003, 2008, 2011</th>
<th>EndNote Web</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Find Citation</strong></td>
<td>EN Web</td>
</tr>
<tr>
<td><strong>Go to</strong></td>
<td>EN Web</td>
</tr>
<tr>
<td><strong>Edit</strong></td>
<td>EN Web</td>
</tr>
<tr>
<td><strong>Citations</strong></td>
<td>EN Web</td>
</tr>
<tr>
<td><strong>List</strong></td>
<td>EN Web</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Word 2007, 2010</th>
<th>EndNote Web</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Find Citation</strong></td>
<td>EN Web</td>
</tr>
<tr>
<td><strong>Go to</strong></td>
<td>EN Web</td>
</tr>
<tr>
<td><strong>Edit</strong></td>
<td>EN Web</td>
</tr>
<tr>
<td><strong>Citations</strong></td>
<td>EN Web</td>
</tr>
<tr>
<td><strong>List</strong></td>
<td>EN Web</td>
</tr>
</tbody>
</table>

Shown below are the buttons for the Cite While You Write commands and short descriptions of their functions. Please note that I have added circles and arrows to some graphics to point out exactly where to click on some buttons that have multiple options on drop-down lists. If you are looking at a color version of this outline, you will see them in bright red (versus the darker red that is part of the original graphics).

8.1 Find Citation

This command opens a search window where you can enter text that is in any field of the reference you wish to find. You can then select references from a list of those that contain your search terms and insert them into your paper.
8.2 Go to EndNote online/Go to EndNote Web

This command will take you to your EndNote online library.

8.3 Format Bibliography

This command will allow you to change the EndNote online style used for your document. It will also let you make other changes to the layout of your bibliography, such as adding titles and changing the line spacing. (In Word 2007, 2010, or 2013, if you wish to change just the style, you can do that using the drop down styles list. If you wish to update your citations and bibliography, you can do just that using the “Update Citations and Bibliography” command. If you wish to do both of these, as well as change line spacing, add titles, and access other formatting options, click on the small arrow at the bottom right of this button (the one the larger arrow is pointing at) to bring up the full Format Bibliography window.)

8.4 Edit Citation(s)

This command must be used to make changes inside a citation, such as adding page numbers or removing author names from author-date citations.

8.5 Unformat Citation(s)/Convert to Unformatted Citations (Word 2007, 2010, 2013)

This command will remove the formatted bibliography and citations and replace all citations with plain-text placeholders that EndNote online can match to library records to create formatted citations. This command is commonly used when moving documents between word-processing programs.

This command will create a second copy of the document with all EndNote online field coding removed (you can generally recognize field codes such as formatted EndNote online citations by their turning grey when you select them in Word). It is used when sending documents to a publisher because the field coding used for EndNote online citations can sometimes cause problems for publishers’ page layout programs. Please note that this command does not create a .TXT plain text file; it creates a Microsoft Word document with the EndNote online field codes removed.

8.7 Export Traveling Library

EndNote online creates a hidden “traveling” library containing only the references used in each paper. This traveling library is part of the coded information contained in each citation. Use this command to export the references in this traveling library to your EndNote online library.

8.8 Cite While You Write Preferences

Use this command to set preferences for EndNote online’s Cite While You Write settings for future documents, and to switch between using EndNote or EndNote online in Word.

8.9 Help

This command will let you access the help files for EndNote online.